ell, here we are again with a new version of Max, and the first

question on the minds of existing users is “Did the interface change?”

The answer is a happy “very little.” Most serious users would rather
go through root canal surgery than have their user interface (UI) change, and
Autodesk has learned and respected this valued opinion by keeping the interface
changes to a minimum.

As you look around the new interface, you'll see that everything is still there but
that Max has a few new additions. You may find yourself saying, as you navigate
the interface, “Where did that come from?” But, just like encountering a new
house in your neighborhood, over time youw'll become accustomed to the
addition and may even meet some new friends.

Why is the software interface so important? Well, consider this: The interface is
the set of controls that enable you to access the program’s features. Without a
good interface, you may never use many of the best features of the software or
spend a frustrating bit of time locating those features. A piece of software can
have all the greatest features, but if the user can’t find or access them, then the
software won't be used to its full potential. Max is a powerful piece of software
with some amazing features, and luckily the interface makes these amazing
features easy to find and use.

The interface’s purpose is to make the software features accessible, and in Max
you have many different ways to access the features. Some of these access meth-
ods are faster than others. This design is intentional because it gives beginning
users an intuitive command and advanced users direct access. For example, to
undo a command, you can choose Edit= Undo (requiring two mouse clicks), but
as you gain more experience, you can simply click the Undo icon on the toolbar
(only one click); an expert with his hands on the keyboard can press Ctrl+Z
without having to reach for the mouse at all. All three of these methods have the
same result, but you can use the one that is easiest for you.
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Has the Max interface succeeded? Yes, to a degree, but like most interfaces, it always has room for improve-
ment, and we hope that each new version takes us closer to the perfect interface (but I'm still looking for
the “read my thoughts” feature). Autodesk has built a loophole into the program to cover anyone who
complains about the interface—customization. If you don’t like the current interface, you can change it to
be exactly what you want.

¢ Customizing the Max interface is covered in Chapter 4, “Customizing the Max Interface
and Setting Preferences.”

This chapter examines the latest incarnation of the Max interface and presents some tips that make the
interface feel comfortable, not cumbersome.

Learning the Interface Elements

If youre new to the Max interface, the first order of business is to take a stroll around the block and meet

the neighbors. The Max interface has a number of interface elements that neatly group all the similar com-
mands together. For example, all the commands for controlling the viewports are grouped together in the

Viewport Navigation Controls found in the lower-right corner of the interface.

If all the details of every interface command were covered in this chapter, it would be an
d awfully long chapter. So for those commands that are covered in more detail elsewhere, |
|nclude a cross-reference to the chapter where you can find their coverage.

The entire interface can be divided into six easy elements. Each of these interface elements, in turn,
has groupings of sub-elements. The six main interface elements are listed here and shown separated in
Figure 1.1:

B Menus: This is the default source for most commands, but also one of the most time-consuming
interface methods. The menus are found along the top edge of the Max window.

B Toolbars: Max includes several toolbars of icon buttons that provide single-click access to
features. These toolbars can float independently or can be docked to an interface edge. The main
toolbar is the only toolbar that is visible by default.

B Ribbon: Configurable tabs and panels provide quick access to modeling features including the
Graphite Modeling Tools.

B Viewports: Four separate views into the scene show the Top, Front, Left, and Perspective view-
points.

B  Command Panel: The major control panel located to the right of the four viewports, it has six
tabbed icons at its top that you can click to open the various panels. Each panel includes rollouts
containing parameters and settings. These rollouts change depending on the object and tab that is
selected.

B Lower Interface Bar: Along the bottom edge of the interface window is a collection of miscella-
neous controls.

= The Ribbon interface is new to 3ds Max 2010.
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Max includes six main interface elements.

Title bar and menus
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In addition to these default elements are several additional interface elements that aren’t initially visible
when Max is first loaded. These additional interface elements include the following:

B Floating toolbars: Several additional toolbars are available as floating toolbars. You access them
by choosing Customize &> Show UI= Show Floating Toolbars or by selecting them from the
toolbar’s right-click pop-up menu.

B  Quadmenus: Right-clicking the active viewport reveals a pop-up menu with up to four panes,
referred to as a quadmenu. Quadmenus offer context-sensitive commands based on the object or
location being clicked and provide one of the quickest ways to access commands.

15
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B Dialog boxes and editors: Some commands open a separate window of controls. These dialog
boxes may contain their own menus, toolbars, and interface elements. A good example of this
interface element type is the Material Editor, which has enough controls to keep you busy for a
while.

Using the Menus

The pull-down menus at the top of the Max interface include most of the features available in Max and are a
great place for beginners to start. Several of the menu commands have corresponding toolbar buttons and
keyboard shortcuts. To execute a menu command, you can choose it from the menu with the mouse cursor,
click its corresponding toolbar button if it has one, or press its keyboard shortcut. You also can select
commands using the keyboard arrows and press the Enter key to execute them.

The main menu includes the following options: Application Button, Edit, Tools, Group, Views, Create,
Modifiers, Animation, Graph Editors, Rendering, Customize, MAXScript, and Help. If you're using 3ds Max
2010 Design, then you'll find one additional menu item, Lighting Analysis. Unlike some other programs, these
menu options do not disappear if not needed. The list is set, and they are always there when you need them.

The File menu has been replaced with a button that displays the Max logo. This is called the Application
Button, and it includes most of the File menu commands. Some of the more common commands have been
located on the Caption Bar for quick access, as shown in Figure 1.2.

¢ Replacing the File menu with the Application Button is new to 3ds Max 2010.

FIGURE 1.2

The Max title bar includes the Application Button, the Caption Bar, and the InfoCenter toolbar.

Application Button

Caption Bar InfoCenter toolbar
e d G- w0 Unititled b peokmpearpnmee | MB-CL By @] —ox

Edit  Tooli  Growp  Wiews  Create  Modifiers  Animation  Graph Edinors  Rendedng  Customize  MAXSoipt  Help

If a keyboard command is available for a menu command, it is shown to the right of the menu item. If an
ellipsis (three dots) appears after a menu item, that menu command causes a separate dialog box to open. A
small black arrow to the right of a menu item indicates that a submenu exists. Clicking the menu item or
holding the mouse over the top of a menu item makes the submenu appear. Toggle menu options (such as
Views = Show Ghosting) change state each time they are selected. If a toggle menu option is enabled, a
small check mark appears to its left; if disabled, no check mark appears.

o ) A complete list of keyboard shortcuts can be found in Bonus Chapter 2, “3ds Max 2010
TN : Keyboard Shortcuts,” on the DVD.

You also can navigate the menus using the keyboard by pressing the Alt key by itself. Doing so selects the
Edit menu, and then you can use the arrow keys to move up and down and between menus. With a menu
selected, you can press the keyboard letter that is underlined to select and execute a menu command. For
example, pressing and holding down the Alt and then E (for Edit) and then pressing U (for Undo) executes
the Edit=> Undo command; or you can press Alt, use the down arrow to select the Undo command, and
press the Enter key.
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By learning the underlined letters in the menu, you can use the keyboard to quickly
access menu commands, even if the menu command doesn’t have an assigned keyboard
shortcut. And because you don’t need to stretch for the Y key while holding down the Ctrl key, under-
lined menu letters can be faster. For example, by pressing Alt, G, and U successively, you can access
the Group= Ungroup menu command. The keyboard buffer remembers the order of the letters you
type regardless of how fast you key them, making it possible to quickly access menu commands using
the keyboard. Over time, you can learn patterns to help you remember how to access certain menu
commands, such as Alt, C, H, E for creating an ellipse.

Not all menu commands are available at all times. If a menu command is unavailable, then it is grayed out,
as shown in Figure 1.3, and you cannot select it. For example, the Clone command is available only when
an object is selected, so if no objects are selected, the Clone command is grayed out and unavailable. After
you select an object, this command becomes available.

FIGURE 1.3

All menus feature visual clues.
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Using the Toolbars

Now that you've learned the menu two-step, it is time for the toolbar one-step. The main toolbar appears
by default directly under the menus at the top of the Max window. Using toolbars is one of the most
convenient ways to execute commands because most commands require only a single click.

Docking and floating toolbars

By default the main toolbar is docked along the top edge of the interface above the viewport, but you can
make any docked toolbar (including the main toolbar) a floating toolbar by clicking and dragging the two
vertical lines on the left (or top) end of the toolbar away from the interface edge. After you separate it from
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the window, you can resize the floating toolbar by dragging on its edges or corners. You can then drag and
dock it to any of the window edges or double-click the toolbar title bar to automatically dock the toolbar to
its latest location. Figure 1.4 shows the main toolbar as a floating panel.

If you right-click any floating toolbar away from the buttons, you can access a pop-up menu that includes
options to dock or float the current toolbar, access the Customize Ul window, or show or hide any of the
toolbars or the Command Panel. The main toolbar can be hidden and made visible again with the Alt+6
keyboard shortcut toggle.

FIGURE 1.4

The main toolbar includes buttons and drop-down lists for controlling many of the most popular Max functions.
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¥ You can customize the buttons that appear on any of the toolbars. See Chapter 4,
% “Customizing the Max Interface and Setting Preferences.”

If you select the Customize > Show Ul Show Floating Toolbars menu command, several additional
toolbars appear. These are floating toolbars. You also can make them appear by selecting them individually
from the toolbar right-click pop-up menu. These floating toolbars include Axis Constraints, Layers, reactor,
Extras, Render Shortcuts, Snaps, Animation Layers, Containers, and Brush Presets.

¢ The Containers toolbar is new to 3ds Max 2010.

The InfoCenter toolbar is now permanently attached to the title bar. Using the InfoCenter toolbar is covered
later in this chapter.

Using tooltips and flyouts

All icon buttons (including those found in toolbars, the Command Panel, and other dialog boxes and
windows) include tooltips, which are identifying text labels. If you hold the mouse cursor over an icon
button, the tooltip label appears. This feature is useful for identifying buttons. If you can’t remember what
a specific button does, hold the cursor over the top of it and the tooltip gives you its name.

All toolbar buttons with a small triangle in the lower-right corner are flyouts. A flyout is a single toolbar
button that expands to reveal additional buttons. Click and hold on the flyout to reveal the additional icons,
and drag to select one. Figure 1.5 shows the flyout for the Align button on the main toolbar.

The General panel of the Preference Settings dialog box contains an option for setting the
number of milliseconds to wait before the flyout appears.

18
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FIGURE 1.5

Flyout menus bundle several toolbar buttons together.
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Using the Caption Bar

Located next to the Application Button is the Caption Bar. It is also called the Quick Access toolbar. This
mini toolbar includes icons for the following commands: New Scene, Open File, Save File, Undo, Redo, and
Set Project Folder. If you click the down arrow icon on the right end of the toolbar, you can access a menu
with options to hide any one of the icons or the entire toolbar. You can also select to show the toolbar
beneath the Ribbon.

& The Caption Bar is new to 3ds Max 2010.

Learning the main toolbar

On smaller resolution screens, the main toolbar is too long to be entirely visible. To see the entire main
toolbar, you need to set your monitor resolution to be at least 1280 pixels wide. To scroll the toolbar to see
the end, position the cursor on the toolbar away from the buttons, such as below one of the drop-down lists
(the cursor changes to a hand); then click and drag the toolbar in either direction. Using the hand cursor to
scroll also works in the Command Panel, Material Editor, and any other place where the panel exceeds the

given space.

The easiest way to scroll the main toolbar is to drag with the middle mouse button.

Toolbar buttons that open dialog boxes such as the Layer Manager, Material Editor, and Render Scene
buttons are toggle buttons. When the dialog box is open, the button is highlighted yellow, indicating that
the dialog box is open. Clicking a highlighted toggle button closes the dialog box. Corresponding menus
(and keyboard shortcuts) work the same way, with a small check mark appearing to the left of the menu
command when a dialog box is opened.

¥ All the main interface icons have been redesigned in 3ds Max 2010.
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Table 1.1 lists the controls found in the main toolbar. Buttons with flyouts are separated with commas.

TABLE 1.1

Main Toolbar Buttons

Toolbar Button

Name

Description

20

Select and Link

Unlink Selection

Bind to Space Warp

Selection Filter drop-down list

Select Object (Q)

Select by Name (H)

Rectangular Selection Region, Circular
Selection Region, Fence Selection
Region, Lasso Selection Region, Paint
Selection Region (Ctrl+F to cycle)

Window/Crossing Toggle

Select and Move (W)

Select and Rotate (E)

Select and Uniform Scale, Select and
Non-Uniform Scale, Select and Squash (R
to cycle)

Reference Coordinate System drop-down
list

Use Pivot Point Center, Use Selection
Center, Use Transform Coordinate Center

Select and Manipulate

Establishes links between objects.
Breaks links between objects.

Assigns objects to be modified by a space
warp.

Limits the type of objects that can be
selected.

Chooses an object.

Opens a dialog box for selecting objects
by name.

Determines the shape used for selecting
objects with the mouse.

Specifies whether an object must be
crossed or windowed to be selected.

Selects an object and allows positional
translations.

Selects an object and allows rotational
transforms.

Selects an object and allows scaling
transforms using different methods.

Specifies the coordinate system used for
transforms.

Specifies the center about which rotations
are completed.

Selects an object and allows parameter
manipulation via a manipulator.
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Toolbar Button

Name

Description

Keyboard Shortcut Override Toggle

Allows keyboard shortcuts for the main
interface and the active dialog box or
feature set to be used when enabled.
Only main interface shortcuts are
available when disabled.

Snap Toggle 2D, Snap Toggle 2.5D, Snap
Toggle 3D (S)

Specifies the snap mode. 2D snaps only
to the active construction grid, 2.5D
snaps to the construction grid or to
geometry projected from the grid, and 3D
snaps to anywhere in 3D space.

Angle Snap Toggle (A)

Causes rotations to snap to specified
angles.

Percent Snap (Shift+Ctrl+P)

Causes scaling to snap to specified
percentages.

Spinner Snap Toggle

Determines the amount a spinner value
changes with each click.

Edit Named Selection Sets

Opens a dialog box for creating and
managing selection sets.

I MNew Set

Named Selection Sets drop-down list

Lists and allows you to select a set of
named objects.

/4]

Mirror Selected Objects

Creates a mirrored copy of the selected
object.

EE D

O i

Align (Alt+A), Quick Align, Normal Align
(Alt+N), Place Highlight (Ctrl+H), Align
to Camera, Align to View

Opens the alignment dialog box for
positioning objects, allows objects to be
aligned by their normals, determines the
location of highlights, and aligns objects
to a camera or view.

Manage Layers

Opens the Layer Manager interface
where you can work with layers.

e

Graphite Modeling Tools

Opens the Graphite Modeling Tools
panel.

EaE

Open Curve Editor

Opens the Function Curves Editor.

Open Schematic View

Opens the Schematic View window.

o]
=

Material Editor (M)

Opens the Material Editor window.

continued
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Toolbar Button Name Description
o Render Setup (F10) Opens the Render Setup dialog box for
setting rendering options.
8 g op
Rendered Frame Window Opens the Rendered Frame Window.
Quick Render (Production), Render Produces a quick test rendering of the
@, \r‘j @ Iterative, Quick Render (ActiveShade) current viewport without opening the

Render Setup dialog box using the
production settings, the iterative render
mode or the ActiveShade window.

;= The Graphite Modeling Tools button is a new addition to the main toolbar in 3ds Max
& 2010.

Using the Ribbon

The Ribbon interface is a deluxe toolbar with many different tool sections. It currently is populated with a
variety of modeling tools that are collectively called the Graphite Modeling Tools. You can turn the Ribbon
on and off using the Graphite Modeling Tools button on the main toolbar. When enabled, tabs for the
Graphite Modeling Tools, Freeform, and Selection are displayed.

The Ribbon buttons are visible only when an Editable Poly object is selected. You can
% learn more about Editable Poly objects and the Graphlte Modeling Tools in Chapter 13,
“Modelmg with Polygons and Using the Graphite Modeling Tools.”

Using the Minimize button at the right end of the Ribbon, you can switch the display mode to show only
the tabs, only the panel titles, or the Full Ribbon. Right-click the Minimize button to access its menu
options. Figure 1.6 shows the Panel Titles and the Full Ribbon modes.

¢ The Ribbon interface is new to 3ds Max 2010.

FIGURE 1.6

The Ribbon can be set to be displayed using several different modes.
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The entire Ribbon, as well as each individual panel of buttons, can be made into a floating control by
dragging the lower panel bar away from the rest of the buttons. When a panel is made into a floating panel,
like the one in Figure 1.7, the icons in the upper right of the floating panel let you return the panel to the
Ribbon or toggle the orientation between vertical and horizontal. You also can move the floating panel
about by dragging on the gray bar on either side of the panel.

FIGURE 1.7

Ribbon panels can float independent of each other.
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Using the Viewports

The four viewports make up the largest area of the entire interface and provide a way of viewing the objects
within the scene. Each of the viewports is configurable and can be unique from the others.

'R ¢ Understanding how to work with the viewports is vital to accomplishing tasks with Max,
At 50 viewports have an entire chapter dedicated just to them — Chapter 2, “Controlling and
Configuring the Viewports.”

Using the Command Panel

If there is one place in Max, besides the viewports, where you'll spend all your time, it’s the Command
Panel (at least until you're comfortable enough with the quadmenus). The Command Panel is located to
the right of the viewports along the right edge of the interface. This is where all the specific parameters,
settings, and controls are located. The Command Panel is split into six panels, each accessed via a tab icon
located at its top. These six tabs are Create, Modify, Hierarchy, Motion, Display, and Utilities.

You can pull away the Command Panel from the right window edge as a floating dialog box, as shown in
Figure 1.8, by clicking the open space to the right of the tabbed icons at the top of the Command Panel and
dragging away from the interface edge. You also can dock it to the left window edge, which is really handy
if you're left-handed. While it’s a floating panel, you can resize the Command Panel by dragging on its
edges or corners (but its width remains constant).

After you've pulled the Command Panel or any of the toolbars away from the interface, you can re-dock
them to their last position by double-clicking their title bar. You also can right-click the title bar to access
the pop-up menu of floating toolbars, but the pop-up menu also includes options to Dock (either Left or
Right for the Command Panel or Left, Right, Top, or Bottom for toolbars) and Float.
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FIGURE 1.8

The Command Panel includes six separate panels accessed via tab icons.
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Working with rollouts

Most of the controls, buttons, and parameters in the Command Panel are contained within sections called
rollouts. A rollout is a grouping of controls positioned under a gray, boxed title, as shown in Figure 1.9.
Each rollout title bar includes a plus or minus sign (a minus sign indicates that the rollout is open; a plus
sign shows closed rollouts). Clicking the rollout title opens or closes the rollout. You also can reposition the
order of the rollouts by dragging the rollout title and dropping it above or below the other rollouts.

You cannot reposition some of the rollouts, such as the Object Type and the Name and
Color rollouts, found in the Create panel.

Right-clicking away from the buttons in a rollout presents a pop-up menu where you can select to close the
rollout you've clicked in, Close All, Open All, or Reset Rollout Order. The pop-up menu also lists all avail-
able rollouts within the current panel with a check mark next to the ones that are open.

Expanding all the rollouts often exceeds the screen space allotted to the Command Panel. If the rollouts
exceed the given space, then a small vertical scroll bar appears at the right edge of the Command Panel. You
can drag this scroll bar to access the rollouts at the bottom of the Command Panel, or you can click away
from the controls when a hand cursor appears. With the hand cursor, click and drag in either direction to
scroll the Command Panel. You also can scroll the Command Panel with the scroll wheel on the mouse.

You can customize the Command Panel like the other toolbars. Customizing the Command
Panel is covered in Chapter 4, “Customizing the Max Interface and Setting Preferences.”

Increasing the Command Panel’s width

The Command Panel can be doubled or tripled (or any multiple as long as you have room) in width by
dragging its left edge toward the center of the interface. The width of the Command Panel is increased at
the expense of the viewports. Figure 1.10 shows the Command Panel double its normal size.
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FIGURE 1.9

Open and close rollouts by clicking the rollout title.

— Opened rollout

— Closed rollout

FIGURE 1.10

Increase the width of the Command Panel by dragging its left edge.
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Tutorial: Rearranging the interface for lefties

I used to work for a company that required that all computers have the mouse to the left of the keyboard.
We swapped computers often, and the boss hated having to move the mouse to the other side of the
keyboard (and you thought your work environment was weird). The reality is that some people like it on
the left and others prefer it on the right, and Max can accommodate both.

With the Command Panel on the right side of the interface, the default Max interface obviously favors
right-handers, but with the docking panels, you can quickly change it to be friendly to lefties.

To rearrange the interface for lefties, follow these steps:

1. Click the Command Panel on the empty space to the right of the Utilities tab, and drag toward the
center of the interface. As you drag the Command Panel away from the right edge, the cursor changes.

2. Continue to drag the Command Panel to the left edge, and the cursor changes again to indicate

that it will be docked when released. Release the mouse button, and the Command Panel docks
to the left side.

3. For an even easier method, you can right-click the Command Panel’s title bar and select
Dock = Left from the pop-up menu.

Figure 1.11 shows the rearranged interface ready for all you southpaws.

& To save the interface changes, use the Customize > Save Custom Ul Scheme menu. The
' maxstart.cui file is loaded by default when Max is started.

FIGURE 1.11

Left-handed users can move the Command Panel to the left side.
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Using the Lower Interface Bar Controls

The last major interface element isn’t really an interface element but just a collection of several sets of
controls located along the bottom edge of the interface window. These controls cannot be pulled away from
the interface like the main toolbar, but you can hide them using Expert Mode (Ctrl+X). These controls,
shown in Figure 1.12, include the following from left to right:

B Time Slider: The Time Slider, located under the viewports, enables you to quickly locate a
specific frame. It spans the number of frames included in the current animation. Dragging the
Time Slider can move you quickly between frames. Clicking the arrow buttons on either side of
the Time Slider moves to the previous or next frame (or key).

B Track Bar: The Track Bar displays animation keys as color-coded rectangles with red for
positional keys, green for rotational keys, and blue for scale keys. Parameter change keys are
denoted by gray rectangles. Using the Track Bar, you can select, move, and delete keys. The
button at the left end of the Track Bar is the Open Mini Curve Editor button. It provides access
to the animation function curves.

B Status Bar: The Status Bar is below the Track Bar. It provides valuable information, such as the
number and type of objects selected, transformation values, and grid size. It also includes the
Selection Lock Toggle, Transform Type-In fields, and the value of the current Grid size.

B Prompt Line: The Prompt Line is text located at the bottom of the window. If you're stuck as to
what to do next, look at the Prompt Line for information on what Max expects. To the right of the
Prompt Line is the Communication Center button for setting how often Max looks for updates. The
Prompt Line also includes buttons for enabling Adaptive Degradation, accessing Communication
Center, and adding and editing Time Tags, which are used to name specific animation frames.

B Key Controls: These controls are for creating animation keys and include two different modes—
Auto Key (keyboard shortcut, N) and Set Key (keyboard shortcut, ). Auto Key mode sets keys for
any changes made to the scene objects. Set Key mode gives you more precise control and sets
keys for the selected filters only when you click the Set Keys button (keyboard shortcut, K).

B Time Controls: Resembling the controls on an audio or video device, the Time Controls offer an
easy way to move through the various animation frames and keys. Based on the selected mode (keys
or frames), the Time Controls can move among the first, previous, next, and last frames or keys.

W Viewport Navigation Controls: In the lower-right corner of the interface are the controls for
manipulating the viewports. They enable you to zoom, pan, and rotate the active viewport’s view.

FIGURE 1.12

The Lower Interface Bar includes several sets of controls.
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Interacting with the Interface

Knowing where all the interface elements are located is only the start. Max includes several interactive
features that make the interface work. Learning these features makes the difference between an interface
that works for you and one that doesn’t.

Gaining quick access with the right-click quadmenus

Quadmenus are pop-up menus with up to four separate sections that surround the cursor, as shown in
Figure 1.13. Right-clicking in the active viewport opens these quadmenus. The contents of the menus
depend on the object selected.

¢ Many of the real pros use quadmenus extensively. One reason is that they can access the
WSS commands from the mouse’s current location using a couple of clicks without having to
go all the way to the Command Panel to click a button.

FIGURE 1.13

Quadmenus contain a host of commands in an easily accessible location.

Clicking with the left mouse button away from the quadmenu closes it. For each menu, the last menu item
selected is displayed in blue. To quickly access the blue menu item again, simply click the gray-shaded bar
for the quadrant that contains the blue menu item. Using Customize = Customize User Interface, you can
specify which commands appear on the quadmenus, but the default options have just about everything you
need.

E F You can learn more about customizing the interface in Chapter 4, “Customizing the Max
% Interface and Setting Preferences.”

If you press and hold the Alt, Ctrl, and Shift keys while right-clicking in the active viewport, you can access
specific sets of commands; Shift+right-click opens the Snap options, Alt+right-click opens Animation
commands, Ctrl+right-click opens a menu of primitives, Shift+Alt+right-click opens a menu of reactor
commands, and Ctrl+Alt+right-click opens a menu of rendering commands.
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Understanding the button color cues

Max’s interface uses color cues to help remind you of the current mode. When a button is yellow, it warns
that it has control of the interface. For example, if one of the select buttons on the main toolbar is selected,
it turns yellow and any dragging in the viewport affects the object; however, if one of the Viewport
Navigation Control buttons is selected, it turns yellow and dragging the viewport changes the view.
Knowing what the current mode is at all times can keep you out of trouble.

Right-clicking in the active viewport exits any Viewport Navigation mode that has control
and returns control to the most recent transform tool. Right-clicking in one of the inactive
viewports keeps the focus where it is and makes that clicked viewport active.

Another common button color is red. When either the Auto Key or Set Key buttons are depressed, they
turn red. The edge of the active viewport being animated along with the Time Slider also turns red. This
reminds you that any modifications will be saved as a key.

Toggle buttons can be turned on and off. Example toggle buttons include the Snap buttons. When a toggle
button is enabled, it also turns yellow. Toggle buttons highlighted in blue are non-exclusive, but they notify
you of a mode that is enabled, such as the Key Mode Toggle or the Affect Pivot Only button.

j= e All interface colors can be customized using the Customize User Interface dialog box,
ot which is discussed in Chapter 4, “Customizing the Max Interface and Setting
Preferences.”

Using drag-and-drop features

Dialog boxes that work with files benefit greatly from Max’s drag-and-drop features. The Material Editor,
Background Image, View File, and Environmental Settings dialog boxes all use drag and drop. These dialog
boxes let you select a file or a material and drag it on top of where you want to apply it. For example, with
the Maps rollout in the Material Editor open, you can drag a texture image filename from Windows
Explorer or the Asset Manager and drop it on the Map button. You can even drag and drop Max files from
Windows Explorer into the Max interface to open them.

Controlling spinners

Spinners are those little controls throughout the interface with a value field and two small arrows to its
right. As you would expect, clicking the up arrow increases the value and clicking the down arrow
decreases the value. The amount of the increase or decrease depends on the setting in the General tab of the
Preference Settings dialog box. Right-clicking the spinner resets the value to its lowest acceptable value.
Another way to control the spinner value is to click the arrows and drag with the mouse. Dragging up
increases the value, and dragging down decreases it.

The effect of the spinner drag is shown in the viewport if the Update During Spinner Drag menu option is
enabled in the Views menu. If the cursor is located within a spinner, you can press Ctrl+N to open the
Numeric Expression Evaluator, which lets you set the value using an expression. For example, you can set a
spinner value by adding numbers together as you would using a calculator. An expression of 30+40+35 sets
the value to 105.

Chapter 34, “Animating with the Expression Controller and Wiring Parameters,” covers
% the Numeric Expression Evaluator in more detail.
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Understanding modeless and persistent dialog boxes

Many dialog boxes in Max are modeless, which means that the dialog box doesn’t need to be closed before
you can work with objects in the background viewports. The Material Editor is an example of a modeless
dialog box. With the Material Editor open, you can create, select, and transform objects in the background.
Other modeless dialog boxes include the Material/Map Browser, the Render Scene dialog box, the Video
Post dialog box, the Transform Type-In dialog box, the Display and Selection Floaters, and the various
graph editors. Pressing the Ctrl+~ keyboard shortcut closes all open dialog boxes. Pressing the same
keyboard shortcut again reopens the dialog boxes that were previously closed.

Another feature of many, but not all, dialog boxes is persistence, which means that values added to a dialog
box remain set when the dialog box is reopened. This feature applies only within a given Max session.
Choosing the Filew> Reset command button or exiting and restarting Max resets all the dialog boxes.

Getting Help

If you get stuck, Max won't leave you stranded. You can turn to several places in Max to get help. The Help
ment is a valuable resource that provides access to references and tutorials. The 3ds Max Help and
MAXScript Help are comprehensive help systems that work like a Web browser. Additional Help presents
help systems for any external plug-ins that are loaded. The Tutorials command loads the tutorials, which
offer a chance to gain valuable experience.

Using the InfoCenter toolbar

With all the various help files, it can be tough to know exactly which one to look in for the information
you need sometimes. To help with this, 3ds Max includes an InfoCenter toolbar. You open this toolbar by
right-clicking it or the Command Panel away from the other buttons and selecting it from the pop-up

menu.

¢ The InfoCenter toolbar has a new location on the title bar in 3ds Max 2010.

When you enter a keyword in the InfoCenter toolbar, Max performs a search and presents a list of
information on where the keyword is found in all the various help files, including Max documentation
and online resources, as shown in Figure 1.14.

You can use wildcards when searching for keywords. The asterisk (*) replaces one or

i more characters, the question mark (?) replaces a single character, and the tilde (~) looks
for prefixes and/or suffixes added to the word. For example, con* finds controller, construct, and
contour; sta? finds star and stat; ~lit finds prelit and relit; and limit~ finds limited and limitless.

Clicking the Search icon located to the right of the search text field (which looks like a tiny pair of binocu-
lars) opens a pop-up menu, which includes options to search only one specific resource or add a search
location to the InfoCenter. This option to add a search location opens a dialog box where you can browse to
a specific document to include in the search. A variety of document types can be searched, including text
files, DOC files, help files, HTML and XML pages, and PDFs.

The pop-up menu also includes an option to access the InfoCenter Settings dialog box, shown in

Figure 1.15. The InfoCenter Settings dialog box also includes settings for configuring the Communication
Center, which is a resource for getting information and announcements from Autodesk. You can configure
the Communication Center to inform you when updates are available, display product support issues, and
even include RSS feeds from Autodesk.



FIGURE 1.14

Exploring the Max Interface _

The InfoCenter toolbar lets you search multiple help files at once.
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FIGURE 1.15

. Within the InfoCenter Settings dialog box is an option to disable those annoying
" balloon notifications that pop up at the bottom of the interface, or you can make them

The InfoCenter Settings dialog box lets you specify which items are searchable.
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You can save specific search items to a Favorites list by clicking the icon that appears at the right end of the
search list next to each article.

Viewing the Essential Skills Movies

When Max first loads, users are greeted with a Learning Movies dialog box, shown in Figure 1.16, that
includes six Essential Skills Movies (seven movies are available in 3ds Max 2009 Design). These simple
movies explain the basics of working with Max.

The Learning Movies dialog box also includes links to What's New and to Learning Path, which are pages
on the Autodesk Web site where you can find more tutorials and resources. After viewing the Essential
Skills Movies, you can disable the Show this dialog at startup option to prevent this dialog box from
appearing next time you start Max. You can access the Learning Movies dialog box at any time using the
Help menu.

FIGURE 1.16

The Learning Movies dialog box includes video clips showing the basic skills you need for working with Max.

; The Essential Skills Movies require an installation of QuickTime.
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Using the browser-based reference guides

The Autodesk 3ds Max Help, What’s New, MAXScript Help, and Tutorials are all Web browser based help
interfaces. An organized list of topics is available in the left navigation pane, as shown in Figure 1.17, and the
right includes a pane where the details on the selected topic are displayed. Across the top are several toolbar
buttons used to control the interface. The Hide button hides the left navigation pane, the Back and Forward
buttons move between visited pages, the Home button returns to the first page of the help file, the Print
button prints the information in the right pane, and the Options button displays a pop-up menu of options.
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The User Reference includes panels for viewing the index of commands and searching the reference.
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Above the left navigation pane are four tabs that open separate panels when selected. The Contents panel
displays a list of topics; the Index panel lists all topics alphabetically; the Search panel includes a text field

where you can search for specific keywords; and the Favorites panel keeps a list of bookmarks to topics you
add to the list.

Throughout the textual descriptions, keywords linked to other related topics are highlighted in blue and
underlined.

Using the rest of the Help menu

The Keyboard Shortcut Map displays an interactive interface for learning all the keyboard shortcuts. The
Help= Data Exchange Solutions menu opens a Web page that explains how to use the FBX format to
exchange files with other software packages. The Customer Involvement Program provides an interface
where you can send feedback to Autodesk regarding 3ds Max. The program lets you send feedback
anonymously or you can include your e-mail.

The next set of help menu commands applies to users with 3ds Max subscriptions. They let you access
various e-Learning lessons, submit and view support requests, and edit your subscription profiles. All of
these commands require that you enter your subscription contract number.

The 3ds Max on the Web options (The Area, Online Support, Updates, Resources, Partners, and Training)
automatically open a Web browser and load the Autodesk Support Web pages or look for updates. The
Area Web site is another excellent resource for help. It is the community site for 3ds Max users.

If you need help from something more personable than a help file, the Area Web site is a
Max community sponsored by Autodesk. It has some awesome help worth looking into.

33



m Getting Started with 3ds Max

The Activate 3ds Max command lets you enter an activation number to authorize the software; the License
Borrowing option lets you borrow and return the current Max license for use on another computer; and
the About 3ds Max command opens the About dialog box, which displays the serial number and current
display driver.
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Summary

You should now be familiar with the interface elements for Max. Understanding the interface is one of the
keys to success in using 3ds Max. Max includes a variety of different interface elements. Among the menus,
toolbars, and keyboard shortcuts, several ways to perform the same command exist. Discover the method
that works best for you.

This chapter covered the following topics:

Learning the interface elements

Viewing and using the pull-down menus
Working with toolbars

Accessing the Command Panel

Learning the lower interface controls
Interacting with the Max interface

Getting additional help

In this chapter, I've skirted about the viewports covering all the other interface elements, but in the next
chapter, you're going to hit the viewports head-on.



